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Meltdown and Spectre. Two words that have brought
a chill to the spine of computer users everywhere.
Linus Torvalds has railed mercilessly on Intel’s
proposed microcode patch for the vulnerabilities,
calling the patch crap. The “patch” and workaround
these issues will cause a significant speed hit to the
Linux kernel. No operating system is immune from
them.

In case you haven’t kept up with the latest and most
major computing drama, Meltdown and Spectre are
vulnerabilities that could allow malicious code to
intercept passwords and other sensitive data, or
even take control over a user’s computer. What’s
worse is that these vulnerabilities were discovered at
the CPU level, in the actual CPUs themselves. The
problem goes back to some poor decision 20 years
ago that has been carried forward ever since. Not
only are virtually all of Intel’s x86 chips affected, but
also AMD’s x86 chips and virtually all ARM chips.
The patch(es) attempt to plug the hole by avoiding
code that uses those particular CPU calls.

In short, things are a royal mess. The patches on
some operating systems (namely Windows) has left
some computer users unable to boot into their
computers, necessitating yet another patch. Linux
users are more fortunate, since (at the time I’m
writing this) Linus Torvalds has released the 4.15
Linux kernel. The 4.15 kernel is said to contain
Linus’s full patch for the two miscreant
vulnerabilities.

Under PCLinuxOS, Texstar was quick to release
updated kernels with the patches. Those kernel
versions are 4.4.110 (LTS), 4.9.75, and 4.14.12 (or
higher). All other kernels should be considered
insecure/unsecure. If you have not yet updated your
Linux kernel to one of these versions, you should do
so posthaste. If you are clinging to some other

version of the Linux kernel for hardware compatibility
issues, you owe it to yourself to either find a
workaround, or to update your hardware to items
that don’t belong in a museum.

Which bring me to yet another random thought:
(some) Linux users are a curious, odd lot. There are
users who use the most ancient, out-of-date,
obsolete hardware they can get away with. Sure,
there is some “joy” in keeping these items out of the
landfill. Sure, there is some “joy” in keeping these
items running. But I’ve seen evidence of more than
that. It seems like some users are personally
attached to these ancient items in the weirdest and

strangest ways. It’s almost as if these obsolete items
are their first born, and are just as reluctant to
surrender them to even moderately more modern
hardware as they are to surrender their first born.

I mean we’re talking about such antiquities as 5x8
dot matrix printers, daisy wheel printers, and other
items from that period in computing history, like
keyboards and mice. I’m actually quite surprised that
they can even find replacement parts or ink ribbons
for them. While the rest of us have moved on and
embraced more modern hardware, they cling to
these relics in a most surreal way, as if they are long
lost lovers.

At some point, you have to let the old technologies
go and embrace newer, better, more capable
technologies. Failure to do so risks being left behind.
I would think that if anyone would or should embrace
newer technologies, it would be Linux users. For so
long, we were the forgotten users. For so long,
hardware manufacturers overlooked Linux users by
never producing Linux drivers for their products.
More recent times has seen that situation change.
Many hardware manufacturers now produce Linux
drivers for their hardware. Tux, the Linux mascot,
now appears alongside the Windows and Mac logos
when listing product support.

Perhaps it is this history that causes a small group of
Linux users to cling to their obsolete hardware. But
we can’t live in the past. We must look forward. It’s
nowhere near as common today to have to “roll your
own” device drivers for hardware. In just the 10
years that I’ve run Linux, I’ve noticed that there is
increasingly less reliance on the “roll your own”
device drivers, and more reliance on drivers
supplied by the hardware manufacturers
themselves.

From The Chief Editor's Desk ...
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If hardware manufacturers start/continue to view
Linux users as a viable and profitable market, then
purchasing their hardware will encourage them to
maintain or increase support for Linux. Money talks,
and everything else walks. Similarly, avoiding the
use of hardware from manufacturers who don’t yet
support Linux also speaks loudly. All of these
companies are in business to make money, and few
(more likely none) of them want to see potential
sales/profit going to their competitors who do
support Linux.

Until next month, I bid you peace, happiness,
serenity and prosperity.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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by Meemaw

I get Tech Republic’s newsletter in my email every
day. Sometimes it’s nice to look through and see
what’s new or what’s going on in the tech world.
Being only a little geeky, I don’t understand a lot of it,
but I always stop and read the articles on MS Office
hacks. I am a LibreOffice user. I even use it at work
rather than MS Office, which is also on the office
computer. When I see those articles, my first
question is always, “how many of these work in
LibreOffice?”

When I was reading recently, I came across just
such an article. This Excel article appeared on
December 4, 2017. As always, I wondered which
would also work in LO, so let’s look.

Number of sheets

When I open LO, and start a new spreadsheet in
Calc, it always starts with one sheet. If your
spreadsheet usually needs more than one sheet,
you can add sheets as needed. You can also
change the number initially provided. To change this
setting go to Options > LibreOffice Calc > Defaults
and change the default for new spreadsheets.

(Remember that you have to have Calc open to find
that section.) You can change the number to
whatever you want, and the next time you open a
new spreadsheet, you will have that many sheets.

Starting workbook

The article says, “If you often work with the same
workbook, you can open it and launch Excel at the
same time. Simply save the file in Excel's XLSTART
folder. If you're using Windows 10, you can find the
folder here:
C:\Users\username\AppData\Roaming\Microsoft\Exc
el\XLSTART” It goes on to give instructions on how
to find that folder in Win10.

While I am sometimes up to changing a file/folder to
get a desired result, I haven’t found that type of
folder in LO. If you find it, please let me know. I think
a much simpler idea is to put a link to that
spreadsheet on your desktop, and simply open it
from there. I have links/shortcuts to several
documents on my desktop at work (Win7 though),
and it’s very handy to open them from there. If you
are someone who hates icons on your desktop (me
at home on Linux), then it’s also easy to open the LO
startup window that has your recent files listed. If
you use that document a lot, it should be listed right
near the top.

Cursor movement

When you press Enter in your spreadsheet, the
default (for LO Calc and Excel) is to move the cursor
down one cell. If you want to move to the right, you
can press Tab instead of Enter, or you can adjust
this behavior as follows:

Go to Options > LibreOffice Calc > General, and
choose the direction you want from the drop-down.

Template modifications

Excel bases all new workbooks on a template called
Book.xltm. I’m sure Calc uses a template as well, but
I can’t find it… (if you know where it is, please tell
me). In the article, “Modifications you make to
Book.xltm are present in all new workbooks. Simply
make the changes you want to persist in all new
workbooks and then save the file appropriately as a
template:
1. Click the File tab and choose Save As.
2. Enter book as the filename.
3. Choose Excel Macro-Enabled Workbook (*.xltm)

from the dropdown.
4. Use the browsing bar above to select your local

drive (probably C:) and then enter the path to
XLSTART.

To use the modified version of Book.xltm, press
Ctrl+N or click New on the Quick Access Toolbar
(QAT). Excel will open a new workbook that reflectsSpecify the number of sheets in new workbooks.

Change the cursor's movement behavior.

LibreOffice Calc Hacks

https://www.techrepublic.com/blog/microsoft-office/10-excel-2016-defaults-you-can-customize/ 
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your template changes. If you want to make more
modifications, be sure to open the Book.xltm
template itself, as you would open any other file.
Be careful when modifying this template. All new
workbooks will present these changes. In addition, if
anything happens to the template, Excel will
generate a new one, and it won't contain your
customizations.”

The best way to have a custom sheet you start up
regularly is to create your own template, saved with
a distinctive name.

Secondary startup folder

From the article, “Some tips rely on the built-in
XLSTART folder. Anything you store in this folder will
open automatically when you launch Excel. You can
add a second startup location as follows:
1. Click the File tab and choose Options.
2. Select Advanced in the left pane.
3. In the General section, enter the path to the

alternate startup folder.
4. Click OK.”

This is to open several files at once, whatever is in
the XLSTART folder, and whatever is in the second
location designated. While it may be good in certain
situations, I don’t usually open a pile of files all at the
same time. If I do, they aren’t only Calc files. I do
several documents for my board meeting every
month at work, but they are usually a combination of
Calc and Writer files. To do that, I open the file
location where they are saved, then select them all
and click open. (I don’t think you can do that in MS
Office anyway, because each type opens in its own
program and won’t open one type from the other
program, meaning that if you are editing a Word file
and need to look at an Excel file, you can’t just go to
the Open dialog in Word and open an Excel file.)

Text Wrap

Long entries often extend past the cell's right border
if the cell isn't wide enough to accommodate them.
When no data lies to the right, it doesn't matter. But
if there's data in the adjacent cell, it will take
precedence, and the long entry to the left will be
partially obscured. If you want long entries to
automatically wrap within their cells, you can change
the Normal style as follows:
1. In Styles & Formatting, right-click Default and

choose Modify.
2. Choose the Alignment tab, and under Properties,

check the box in front of Wrap text automatically

This default works in the current workbook only.
Bear in mind that wrapping text will increase the
height of that row.

Expanded formula bar

The formula bar's height (or depth) is adequate for
most of us, but those who enter long expressions
might benefit from more space. Fortunately, it's easy
to achieve. Looking at the right end of the formula
bar (see the red circles below), click on the down
arrow (top) to expand it, then the up arrow (bottom)
to reduce it again.

Recent documents list

When you open the list of recent documents,
LibreOffice has defaulted to 25. I’ll have to say that’s
enough for me, unless I have been searching for
something particular. MS Office has made this one a
bit easier to change, with a drop-down in Advanced
Options that says “Show this number of recent Excel
workbooks”.

In LO, we need to open the Expert Configuration
window, which is opened by going to Options >
LibreOffice > Advanced and clicking on Expert
Configuration. You will have a window much like
the about:config tab in Firefox. BE CAREFUL!

Make Text Wrap the default.

Increase the height of the formula bar to accommodate
long expressions.

LibreOffice Calc Hacks
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I did, however, find the setting for the recents list. It
is under org.openoffice.Office.Common. Double click
the plus sign and look for History. Double click that
and look for Pick List History. The settings at the
right side should say PickListSize long 25. Double
click the number and a window will appear to let you
change that number. This will show recent
documents from all sections, not just Calc. I
changed mine to 20 at work.

Ruler measurement

LibreOffice (and Excel) ruler measurements default
to inches. But inches won't always be appropriate.
You can quickly change the measurement as
follows: Go to Options > LibreOffice Calc >
General and you can change to the units you want.

LibreOffice has been updated to Version 5.4.4.2.
The other improvements can be reviewed here.

You have seen some easy ways to set defaults that
work the way you work, but there are many more.
Spend time in LibreOffice Options and you might find
other easy changes you can make.

Specify the number of recently opened files displayed.

Change the ruler measurement to centimeters or millimeters.

Screenshot ShowcaseScreenshot Showcase

Linux Training
Courses & Classes

Posted by Mr Cranky Pants YouCanToo, January 13, 2018, running KDE.

LibreOffice Calc Hacks

https://wiki.documentfoundation.org/ReleaseNotes/5.4#New_spreadsheet_functions


PCLinuxOS Magazine Page 8

by phorneker

When it comes to digital photography, the first thing
that Linux users have in mind for picture editing is
the GNU Image Manipulation Program (or simply
GIMP). Sure, I have used that product for years for
digital photography.

The other product I use just as often, is the photo
management program that was designed for KDE
called DigiKam, and that is the subject of this article.

DigiKam was originally designed as a photo
management program, with many of the file
management functions that are available in the
Dolphin file manager.

However, many capabilities have been added to the
software package, including a photo editor with
capabilities that facilitate many things I could do in
the GIMP (and less time consuming at that), and the
integration of Internet services such as Google
Photos and Flickr, as well as the creation of online
photo galleries.

When you launch DigiKam for the first time, it will
scan the Pictures directory for anything that is
considered a picture or a video file. This could be a
JPEG, PNG, TIFF, MOV, MP4, or other supported
standard format. If you have a large collection,
this will take a considerable amount of time for
DigiKam to scan for image and videos (center,
top).

Within DigiKam, Albums are simply subdirectories
created and maintained inside the Pictures directory
on your hard drive. When you create an album in
DigiKam, you are really creating a subdirectory

inside the Pictures directory within your home
directory.

There are three panels and two sidebars that make
up the user interface for DigiKam. The left panel
keeps track of Albums that DigiKam uses. By
default, DigiKam sources its photograph collection
from the Pictures directory within your home
directory. Here Pictures is an album within the list of
Albums that DigiKam keeps track of.

The main panel is where actual content is displayed.
In this example, the top level Albums is selected,
and the locally stored homepage for your installation
of Digikam is displayed. Selecting any of the other
folders in the left panel will display the contents of
that directory in the main panel.

Here we have a light table view of a collection of
photographs stored in
“~/Pictures/Architecture/Chicago Field Trip 1988”
on my laptop (right, top).

During my junior year at Valparaiso University, I took
a class called “History of American Architecture”
that included a field trip to Oak Park, IL, as well as
parts of Chicago to visit (and study) buildings

designed by Frank Lloyd Wright. The pictures on this
DigiKam screen were scanned from photographs I
took on that field trip.

The panel on the right is a multipurpose panel, and
is where most of the functionality of DigiKam
happens. On the right edge of this panel are vertical
tabs. What appears in this panel depends on what
tab has been currently selected. The same is true for
the left edge of the left panel.

Here, the current tab selected is Properties. What is
displayed here is some basic information on the

DigiKam: The Other GIMP For Photographers
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selected photograph. In this example, the selected
photograph is the highlighted image (in cyan) at the
top left hand corner of the light table.

File Properties gives information about the file that
has been selected. Here, the file is called class-
grouping.jpg, located in
“/home/patrick/Pictures/Architecture/Chicago
Field Trip 1988” (without the quotes, but including
the spaces in the pathname). This photograph was
scanned at 600dpi and has a image size of
5776x4191, and weighs in at 3.4MB after JPEG
compression.

Let us now click on the highlighted photograph.

We now get a full view of the selected photograph,
along with a filmstrip of adjacent images contained
in the same directory. Click on any of those to scroll
through the directory.

As we scroll through the directory, notice that the
information displayed in the right panel changes with
the selections.

This sculpture is located in front of the Daley Plaza
in downtown Chicago. I framed this so you, the
viewer, can make your own decisions as to what is
conveyed in the sculpture. This photograph was
processed in June of 1988 as indicated at the lower
right hand corner of the photograph. The actual
photograph was taken about two months earlier.

...and this building used to be a functioning Marshall
Field’s store in downtown Oak Park. Its architecture
was obviously inspired by Louis Sullivan’s design of
the State Street store (now Macy’s), including the
clock at the southwest corner of the building. (The
image was scanned at 150dpi.)

As this is a scanned picture, there are not going to
be any metatags attached to this file.

The other tabs on the right
panel provide information (and
editing where possible) on
Metatags, Color Profiles,
Maps (for Geotagging),
Captions, Versions, Filters,
and Tools.

Filters here refers to
searching the database of
photographs and video. What
can be searched here is the
type of image or video,
metatag and geographic
location.

Also, tags can be labelled and
images and videos can be
locally rated (up to five stars).
(This type of labelling also
exists in Shotwell, the GNOME

DigiKam: The Other GIMP For Photographers
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equivalent to DigiKam, which was recently added to
the repository. Personally, I prefer to use DigiKam).

The Tools tab, is what makes DigiKam the product
that it is.

What is shown here is only a sample of what can be
achieved in DigiKam.

This is only an introduction to DigiKam. There is a lot
more to cover starting with the Tools tab and the
things it can do. Also, there is a powerful image
editor (called showfoto in the repository and is
downloaded at the same time DigiKam is installed
from the repository.)

For the record, I currently own the following
photographic gear:

• Sony Cybershot DSC-H10 (my primary digital
camera with Zeiss lens, 8 megapixel)
• Sony Cybershot DSC-W170 (purchased at

Goodwill, sharing the same USB cable, batteries

and memory cards with the DSC-H10,
10 megapixel compact)
• General Imaging Company A1255 (purchased at

Goodwill, GE branded 12.2 megapixel camera
taking SD-HC memory cards and standard USB
type B connector)
• HDV180 “Jazz” video camcorder (from Big Lots,

from Sakar International, 12 megapixel still
images, 1280 x 720 HD video, taking standard
SD-HC memory cards and standard USB type B
connector.)
• Cobra “Black Friday” special (Christmas gift

purchased at Kohl’s back in 2008, 8 megapixel,
standard SD card up to 2GB, standard USB type
B connector)
• Vivitar ViviCam 3340 (received as a Christmas gift

back in 2004, 1.3 megapixel second generation
digital camera, no LCD display, standard SD card,
standard USB type B connector)
• Mamiya Sekor 528TL (rare film SLR camera

purchased at Goodwill, fixed 48mm f/2.8 lens,
shutter speeds 1/15 to 1/500 second, and time
exposure. Works great considering its age)
• Pentax K-1000 (my current primary film camera.

Purchased at Goodwill, this 1976 vintage camera
was one of the last Japanese built K-1000 models
with the words “Asahi Pentax” printed above the
lens mount. The body was constructed of steel
as opposed to the plastic models found in later
versions of the K-1000 as late as the 1990s. This
camera came with a SMC Pentax-M 50mm f/2.0
lens.)
• Aiptek DUO-V26 digital camcorder. (purchased at

Goodwill, takes Compact Flash card, which was
reformatted for FAT12 with 2GB capacity,
standard USB type B connector)

Also included in the camera are the following:

• Pentax SMC-F 28-80mm f/3.5-4.5 autofocus zoom
lens (standard Pentax K mount so it will work with
the K-1000, and if I choose to replace the
Cybershots with a Pentax DSLR, this lens will
work with that camera as well as the basic Pentax

K mount has not changed in design over the
years.)
• DeJUR 135mm f/2.8 lens for the K-1000. (This

was purchased with the K-1000)
• DeJUR 2x Teleconverter for the K-1000. (Both the

135mm lens and the teleconverter were made in
Japan.)
• Minolta Auto 200X flash with a translucent panel

for wide angle lenses
• Lenmar EF32 manual flash
• Pentax AF-200S automatic flash
• Sets of 49mm, 55mm and 58mm filters of various

types, including the Cokin filter system

Previous equipment I owned (but no longer do):

• Rolleiflex SL-35M (purchased in 1997, broke down
in 2007 after ten years of heavy usage. This was
my primary film camera that got replaced with the
Cybershot DSC-H10. The reason for that choice:
Both cameras came with Zeiss lenses.)
• Minolta XG-1 (shutter failed after battery

replacement)
• Canon Canonet QL-19 (this was my primary film

camera before the SL-35M and was the camera
used to take the pictures shown in this article.
This was a 35mm rangefinder that had very much
the same lens and shutter mechanism as the
Mamiya Sekor 528TL, which is one reason why I
purchased that camera.)
• Olympus XA-2 (this was a Christmas gift I got

back in 1982, and lasted for 25 years! Donated to
Goodwill in 2007 after I purchased by Cybershot
DSC-H10 as part of my inventory reduction)
• Argus DC-1510 (A first generation digital camera

that had promise to be a great camera, but did not
deliver due to poor picture quality, though it was
Linux compatible.)
• Argus C3 (This was the Ford Model T of film

cameras.)

DigiKam: The Other GIMP For Photographers
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by Paul Arnote (parnote)

In today’s digital world, we rely on our computers for
many, many things. One thing that our computers
have become particularly useful for is safekeeping
files full of vital or important information.

There is little else as distressing as losing an
absolutely vital file. It could be the last pictures of

grandma before she died. A list of serial numbers for
household items. A presentation you spent weeks
working on. An encrypted list of passwords. I’m sure
you can probably think of a thousand different
situations, and certainly situations that are unique to
your own computing.

Keep in mind that we’re not talking about file security
here. Work on the assumption that anyone will be
able to access your vital files. But what we’re talking

about here is helping to insure that those vital files
are not easily deleted, either accidentally or
purposefully.

Fortunately, there are at least two solutions to help
prevent the deletion of files. Let’s take a look at each
method.

Method #1: Use The Tools You Already Have

Believe it or not, all of the tools you need to protect
your files from deletion were installed from the first
day you installed PCLinuxOS. You just probably
didn’t know they were there, or how to use them.
Maybe you’re already somewhat familiar with the
tools, but forgot about them. Either way, this method
employs very low overhead, since there’s nothing
else to install on your computer.

Specifically, I’m talking about the chattr (change
attribute) command. To run it, you need to be root.
But otherwise, it’s fairly straight forward. While there
are several flags that can be used with chattr, we’re
going to concern ourselves with the i and a flags,
primarily. You can learn about the other flags by
entering man chattr at a command prompt. (While
there is a chattr flag for “undeletable,” it does not
work on the ext3 and ext4 file systems, which is
probably what most PCLinuxOS users use).

Issue the command (as root) as follows:

chattr +i yourfile.ext

This will change the file attribute to “immutable.”
When the file attribute is set to immutable, NO ONE,
not even the root user, can delete the file. The file
cannot even be changed by anyone. In order to
delete (or change) the file, you will need to change

Two Ways To Protect Your Files
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the file attribute to remove the immutable flag. Thus,
you remove the immutable flag like this:

chattr -i yourfile.ext

Again, you have to run the command as root. Once
the immutable flag is removed, it can be deleted (or
changed) just like any other file on your computer,
provided you have proper file permissions to do so.
If you are merely updating a file and want to restore
the immutable flag, don’t forget to rerun the first
chattr command after you’re done editing the file.

It seems like a lot to go through just to protect a file,
but then think of the consequences of deleting an
irreplaceable file. The command is fast and easy to
execute, and gives you a literal metric ton of peace
of mind.

However, you can use the a flag, instead of the i
flag. The a flag stands “append only.” Doing so
allows you to edit, modify and append the file, but
prevents the deletion of the file. The format for the
command is virtually identical to using the i flag,
except you use the a flag, like this (ran as the root
user):

chattr +a yourfile.ext

Similarly, you can remove the a flag, like this:

chattr -a yourfile.ext

Once the a flag is removed, you will be able to
delete the file, just like any other on your system.
While it may be more convenient to use the “append
only” flag, it doesn’t afford you as much protection as
the immutable flag. So, if you’re worried about the
contents of your file being changed, you might want
to stick to using the immutable flag.

In real world use, you can combine these flags with
others. For example, if you want to make a directory
immutable, along with all of the files in a directory,
simply issue the command like this:

chattr -R +i /home/username/directory

The -R flag means to recurse the directory. This
makes the directory and all of the files within that
directory immutable. You can also use the “append
only” flag in the same manner. Done this way,
neither the directory nor any of the files within it can
be deleted until the immutable or “append only” flag
is removed (with -i or -a).

The chattr command also allows for the use of
standard wildcards. You can get similar results by

travelling to the directory containing the files you
want to protect, and issuing the command like this:

chattr +i *.*

This will make all of the files in that directory
immutable, and thus unable to be deleted.

Linux Docs
Linux Man Pages

Two Ways To Protect Your Files

http://www.die.net/
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Method #2: Use Python rm-protection

To use this method, you will need to install a couple
of additional things to your computer. First, you will
need to install python-pip from the PCLinuxOS
repository. This is the installer for other Python
scripts/programs. Then, you will need to download
rm-protection from GitHub. Download it as a ZIP
file, then decompress it into a directory in your
/home folder. Then, from a command line prompt, su
to root, and execute pip install path/to/program
(where path/to/program is the location where you
decompressed rm-protection). For example, if you
decompressed the files for rm-protection to
~/Downloads/rm-protection, your command would
be pip install /home/user/Downloads/rm-
protection/rm-protection.

The rm-protection “package” from GitHub contains
two programs: rm-p and protect. You specify which
files to protect. From a command line, enter protect
yourfile.ext (you can also specify a fully qualified
path before the filename). It will then ask you for a
verification question. You decide what the question
is, so make it something that only you know the
answer to. Then, you supply the answer to the
question you just designated as the verification
question. That answer is stored in the current
directory in the file named .yourfile.ext.rm-protection
(“yourfile.ext” will match the name of the file you
specify that you want to protect).

To delete a file, enter rm-p yourfile.ext. The
verification question will be displayed. If you answer
correctly, the file will be deleted. If you don’t answer

correctly, the file will not be deleted. It’s really that
simple. Below is a sample readout from rm-p:

rm-p: /home/user/yourfile.ext: What is your
favorite Linux?
Answer: Ubuntu
rm-p: Wrong answer! /home/user/yourfile.ext
will not be removed
rm-p: The answer is stored in
/home/user/.yourfile.ext.rm-protection
rm: missing operand
Try 'rm --help' for more information.

Of course, the above readout is from giving the
wrong answer to the verification question. Had the
answer been correct, the specified file would simply
have been deleted, with no need for verbose output.

Keep in mind that the answer is case sensitive.
Thus, “pclinuxos” is different from “PCLinuxOS,”
which is different from “PCLINUXOS.” Also, rm-
protection only protects a normal user’s files. The
root user still has the ability to delete a user’s file(s),
even if it is “protected.”

As with chattr, the protect and rm-p commands
recognize the -R flag, which protects the directory
specified, as well as all of the files contained within
the directory.

Summary

Both methods take different approaches with a
single goal in mind: protect your files from deletion.
Don’t confuse this with file security. This is ONLY to
protect your files from deletion – accidental or
purposeful. Your “protected” files content can still be
read by anyone with proper access to your
computer.

Also, this method won’t protect your files from
erasure by reformatting your hard drive. But then, I
suppose nothing will protect them in that eventuality.
The only way to be certain that your critical, vital and
important files remain safe is to properly back them
up.

Donate NOW

DOWNLOAD

Mate Desktop

Two Ways To Protect Your Files

http://www.gofundme.com/pclinuxos-2016
https://www.edx.org/course/introduction-linux-linuxfoundationx-lfs101x-0#!
https://github.com/alanzchen/rm-protection
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If I could talk to Texstar just imagine it
Conversing with an OS tsar
Imagine our chitter chatter
About things that matter
It would be a bit bizarre

If I could talk to Texstar learn the terminal
I know he would agree
To teach me the coding
Synaptic uploading
Oh how helpful I would be

We would jibber jabber in python
Invent a new script or two
If people ask can I jive in java
I'd say yes can't you

I'd impress all my forum pals
All the guys and gals
How amazing it would be

If I could walk with Texstar talk with Texstar
Verbalize vocalize
And he would enunciate articulate with me

ms_meme's Nook: If I Could Talk To Texstar

MP3 OGG

http://pclosmag.com/html/Issues/201802/files/ificouldtalktotexstar.mp3
http://pclosmag.com/html/Issues/201802/files/ificouldtalktotexstar.ogg
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INGREDIENTS:

3 cups Corn Chex™ cereal
3 cups Rice Chex™ cereal
3 cups Wheat Chex™ cereal
1 cup mixed nuts
1 cup bite-size pretzels
1 cup garlic-flavor bite-size bagel chips
6 tablespoons butter or margarine
2 tablespoons Worcestershire sauce
1 1/2 teaspoons seasoned salt
3/4 teaspoon garlic powder
1/2 teaspoon onion powder

DIRECTIONS:

In large microwavable bowl, mix cereals, nuts,
pretzels and bagel chips; set aside. In small
microwavable bowl, microwave butter uncovered on
High about 40 seconds or until melted. Stir in
seasonings. Pour over cereal mixture; stir until
evenly coated.

Microwave uncovered on High 5 to 6 minutes,
thoroughly stirring every 2 minutes. Spread on paper
towels to cool. Store in airtight container.

Don't like the microwave?

Heat oven to 250F. In large bowl, mix cereals, nuts,
pretzels and bagel chips; set aside. In ungreased
large roasting pan, melt butter in oven. Stir in
seasonings. Gradually stir in cereal mixture until
evenly coated. Bake 1 hour, stirring every 15
minutes. Spread on paper towels to cool, about 15
minutes. Store in airtight container.

The PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner

Chex Mix

http://www.scribus.net
http://www.jupiterbroadcasting.com/tag/linux-action-show/
http://www.fsf.org
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by Alessandro Ebersol (Agent Smith)

The war against the Kilrathi is going badly for the
Confederation. Its flagship, the Concord, was
destroyed, battles are lost on all fronts. The war
hero, Colonel Christopher Blair, is transferred to the
old carrier ship Victory. Take the role of Blair and
ensure the success of the final attempt of the
Confederation to the victory: the destruction of the
home world of the Kilrathi, Kilrah.
You must fight with determination: The future of the
human race is in your hands!

Wow... This brief intro puts the player in the spirit of
Wing Commander III - The Heart of the Tiger, an
adventure that, despite being 24 years old, still runs
great.

Wing Commander III - The Heart of the Tiger -
The Game

Here I reproduce some promo's, from the time when
the game was released:

The first real interactive movie for your home PC.

Filmed professionally in Hollywood, a production of
millions of dollars from ORIGIN, combines movie
entertainment with the interactivity of computer
games. The result is a spectacular space flight
adventure.

Adrenaline, romance, humor, danger - Wing
Commander III has it all and more. This sequence
completes the turbulent chronicles of the Terran-
Kilrathi war. The final confrontation takes place in
one of the worlds - Earth or Kilrah. But only you can
write the end...

Features:

• A - list Hollywood cast: Mark Hamill, John Rhys-
Davies, Malcolm McDowell, Tom Wilson, Jason
Bernard, Ginger Allen, Tim Curry (voice), Josh
Lucas and Courtney Gains.
• Interact with characters to control the plot, the path

of the talks and the ending.
• Fifty intense missions - each with photo realistic

3D space combat (Well, it was in 1994).
• 16-bit full digital soundtrack for the cutscenes, and

General MIDI support and synthesized voices
during space combat.

• 32-bit computer technology fully utilizes the power
of your 486 or Pentium™ (LOL).

• Explore virtual scenarios rendered by SGI (Silicon
Graphics Image) in VGA and SVGA.

• Invisible cockpit, 3D navigation system, stealth
technology, instant missions and more.

• Pilot five distinct ships, armed with fully
configurable weapons.

• Play directly from the CD - more than 3 hours of
video in live action, plus dozens of hours of
gameplay. (well, now this is not possible because
it is an electronic download. But the 3 hours of
video are present. Only CD's are not)

Creating Wing Commander III

Wing Commander III: Heart of the Tiger was
developed and released by Origin Systems.
Released on December 8, 1994 for MS-DOS and
Mac OS, in 1995 for the 3DO and in 1996 for the
PlayStation (a version for the Sega Saturn was also
announced, but was never released), Wing
Commander III made the switch from 2D graphics
based sprites, used in previous titles, to the
polygonal 3D graphics with texture mapping and
FMV (Full Motion Video) used for cutscenes. The
new formats of the ships, more angular and blocky,
were made necessary because of the state of
polygonal graphics, primitive at that time, since
WCIII was released before 3D accelerator cards
were released, and all calculations were done by
the CPU.

The live action scenes were filmed in front of green
screens, almost everything in the scene was
computer generated (except things like chairs,

It's him! Luke! No ... It's Mark Hamill as Chris Blair ...

GOG's Gems:
Wing Commander III: Heart Of The Tiger
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tables and the bar in the recreation room, beds and
lockers, etc.).

Giant Kilrathi characters are played by men using
animatronic heads, hairy hands and boots that add
about a foot high and create the appearance of cat
legs.

The budget for the live action cutscenes cost US$ 4
million and was the most expensive game produced
at the time.

The cast of A class Hollywood actors:

• Mark Hamill as Christopher "Maverick" Blair
• Malcolm McDowell as Admiral Tolwyn
• John Rhys-Davies as Thrakhath nar Kiranka

(voice) and James "Paladin" Taggart
• Jason Bernard as Capt. William Eisen
• Tom Wilson as Maj. Todd "Maniac" Marshall
• Ginger Lynn Allen as Rachel Coriolis
• Jennifer MacDonald as Lt. Robin "Flint" Peters
• Courtney Gains as Lt. Ted "Radio" Rollins
• François Chau as Lt. Winston "Vagabond"

Chang
• BJ Jefferson as Lt. Laurel "Cobra" Buckley
• Josh Lucas as Major Jace "Flash" Dillon
• Julian Reyes as Lt. Mitchell "Vaquero" Lopez

• Yolanda Jilot as Col. Jeannette "Angel"
Devereaux
• Barbara Niven as Barbara Miles
• Tim Curry as Melek nar Kiranka (voice)
• Alan Mandell as Emperor (voice )
• John Schuck as nar Ralgha "Hobbes" Hhallas

(voice)

Several versions of the same scene were shot, and
the decisions of the player alternate between one
version and the others.

A Pentium class CPU (then a high-end processor)
was needed to get the best performance of Wing
Commander III. Chris Roberts, the creator, said: "We
are not afraid to push a little the hardware sales, and
we believe that the Pentium will soon be the
standard."

A novel by William R. Forstchen and Andrew Keith
was published in 1995. An adaptation of collectible
card games was published the same year by Mag
Force 7 Productions under the direction of notable
science fiction authors Margaret Weis and Don
Perrin.

After the end of Origin’s official support, the fan
community itself began offering support for the
game. For example, the community has developed
various unofficial patches to improve compatibility
with the latest versions of Windows and the latest
PC hardware.

In September 2011, the source code of Wing
Commander III was released to the fan community
by a former developer, for the purpose of digital
long-term preservation.

On September 13, 2011, WC III was re-released in
gog.com in digital distribution.

Review

What can I write about this game? Words fail me,
but I will try to describe how it feels to play this
classic, and, how it is still powerful, even after 24
years.

Graphics

Impressive for the time, the graphics are still good
today. I do not mean so much the graphics of the
game itself, but the fantastic cutscenes, so well

LOCKED GOG's Gems: Wing Commander III: Heart of the Tiger

http://www.commandlinefu.com
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done, that stood the test of time. The mix of actors
with virtual sets was very well done, and it is
amazing what they could do with the technology of
that time (1994) when 486 was a high end and a
Sound Blaster Pro was the common sound card.

The game graphics do not impress much, as they
are rather primitive vector graphics, but they fulfil
the task of putting the player in the space, in the
heat of battles, that, thanks the high production
values, are always exciting.

The most amazing part are the Kilrathi, the aliens
that look like giant tigers. Their design was so
perfect, the making and handling of the heads so
well done, you will believe that they are real
creatures. Grade A, with honors!

Sound

Perfect, there is nothing to complain about. In
cutscenes, audio is orchestrated, and in the
simulation sections of the game the musics are in
MIDI format, which was the standard back then.

The voice acting is fantastic, and of course actors
like Mark Hamill (Star Wars), Tom Wilson (Back to
the Future), John Rhys-Davies (LOTR trilogy) never
drop the ball.

Gameplay

It is a 3D space flight simulator. So, there is
obviously no gravity, but realistic physics do not
apply. If you slow down to zero, you stop. You can
rotate and roll, but you can not reverse, nor can you
steer the ship vertically. And in some spaceships,
you can perform a sliding maneuver so you can
rotate and keep firing at your target while sliding for
a later position. That is more arcade like than a
realistic simulator. But it never spoils the fun. The
ships run smoothly and each has a different feeling.
The game supports joystick, keyboard and mouse. I
definitely recommend a joystick, a mouse to track
these enemies can feel awkward.

The game has five different endings, two good and
three bad. Therefore, the replay factor is good, since
it keeps the interest to not know every possible
ending of the story.

Verdict

Buy Immediately. The game is simply amazing, even
at 24 years old. It aged very well, like a good wine.
Even today, it is still impressive, especially the
Kilrathi, imposing and scary, their menacing figure
works very well, and the impeccable performance of
each of the actors is mesmerizing: you get hooked
on the story, rooting for your alter-ego (Chris Blair /
Mark Hamill) and care and are moved by each of the
characters, so well they have been written and
interpreted. And if you were disappointed with The
Last Jedi, like me, you can follow the space
adventures of Mark Hamill, at a time when the future
of humanity in space was brilliant, not a melancholy
end, drinking green milk from a sea cow (seriously
Rian Johnson, you will not go to heaven after that).
And the FMV games are back, having Night Trap
been re-released for current systems recently, and
Late Shift, a new FMV game, in high resolution, was
also released not long ago.

Credits:

Developer: Origin systems
Publisher: Electronic Arts
Designer: Chris Roberts
Composer: George Oldziey
URL GoG:
https://www.gog.com/game/wing_commander_3_he
art_of_the_tiger
Price: US$ 6.00
Size: 1.6 GB

Requirements:

Play-on-Linux. It is an old game that runs via
DOSBox. It has an installation by POL, in which you
run POL, and choose install the game Wing

LOCKED GOG's Gems: Wing Commander III: Heart of the Tiger

https://www.gog.com/game/wing_commander_3_heart_of_the_tiger
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Commander 3. The installation is automatic and
without any major problems.

I recommend visiting this page:
http://www.wcnews.com/wcpedia/Category:Wing_Co
mmander_III:_Heart_of_the_Tiger
It has many tips, information and tools for the game.

Also, here are two videos, one with a behind the
scenes and gag reel of the game:
https://www.youtube.com/watch?v=CpjreO8W2G8
https://www.youtube.com/watch?v=3DbsI0y2DncAM

I hope you like it. To the Infinite! And away!

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!
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Posted by cstrike77, January 13, 2018, running KDE.
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by Meemaw

This tutorial is really fun, and
you end up with a pretty
clipart rose.

Draw a simple circle for the
top of the flower.

Use the Spiral tool to draw a spiral within the circle.
You may have to change the settings a bit. I
changed Turns to 2. You can always draw it outside
and drag it into the circle. The outer end of the curve
needs to be on the circle somewhere.

Select the circle and spiral and flatten them a bit.
While they’re still selected, click on Path > Object to
Path to convert them.

To add character to our rose, let’s use tapered lines.
The first step is to draw a flat ellipse somewhere on
your page, then copy it to your clipboard.

Open the Path > Path Effect Editor. Select the
spiral, add a Pattern Along Path effect, and then
click Paste path (the clipboard) for the pattern
source. Since the ellipse was copied to the
clipboard, its shape will now be stretched along the
spiral.

Adjusting the stroke width to 6 will result in this (top,
right):

Now let’s do the rest of the flower. Using the Pencil
tool, with the shape changed to Triangle Out, draw
a triangle shape (right).

Next, click on the Nodes tool and move the sides so
they are rounded.

Inkscape Tutorial: Create A Rose
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We want a red rose, don’t we? However, you’ll
notice that you can’t fill this shape since it isn’t
closed. So, duplicate the tapered line, click on Path
> Remove Path Effect, and then change the color
of your new section to red.

Move the colored section behind the tapered line,
and change the fill on the top circle to red as well.

Before I finish with the flower itself, I want to add
some detail. With the swirl in the center ending at
the bottom right side of the top, that’s naturally
where the petal edge should be, so I will use the
pencil tool again to add a line on top of the flower
that imitates the edge of the petal (center, top). To
easily move the flower, select all and group the
parts.

To finish the flower, we need to draw the stem and
some leaves. Using the Pen tool with a Triangle In
shape, draw a very slightly curved line.

The leaves are pretty easy. Use
the Pencil tool with a Triangle In
shape and draw a couple of
freehand lines. Increase the
Smoothing until you get the result
you want. Mine was 50. Draw
another line down the middle for
detail.

To color the leaf, do the same thing as you did with
the flower - create a copy and click on Path >
Remove Path Effect and change the fill to green.
Place the green section under the outline section.
You can make as many leaves as you want by
grouping the original (if you haven’t already),
duplicating it, flipping it horizontally and placing the
copies on the stem. You can also change the size or
rotate them to get the effect you want (top, right).

We’re finished! That was fun!

If you want to change the background that’s up to
you. Save and export your rose in whatever image
format you want. I made several for a Valentine’s
Day bouquet.

Inkscape Tutorial: Create A Rose
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by phorneker

For the past two months, I mentioned that just
because we use PCLinuxOS does not mean that we
are completely safe and secure from the common
problems faced by Windows and Mac OS-X users.

This past two weeks brought two new terms to the
Linux scene: Spectre and Meltdown. I mentioned
that we were lucky about malware not affecting
Linux users. Though Spectre and Meltdown are
actually design flaws in microprocessors built over
the past twenty years, they pose security risks now
affecting Linux users. (Note that the title of this
series is called From the “I Told You So”
Department.)

Thankfully, Texstar has patched the 4.4, 4.9 and the
current kernels to avert any potential security and
safety problems that would have occurred with
Meltdown and Spectre.

Hence, it is imperative that we update the kernel
to the latest version available in the repository.

To update the kernel in PCLinuxOS, open Synaptic,
click on Reload, then click on Status.

If an updated kernel has been uploaded to the
repository, it will be found under New in repository.
Select any package with kernel in its name. Both the
kernel and its development package will be selected.
Click on Apply to install the new kernel.

Synaptic will automatically update the bootloader
and show you the changes.

Then reboot your PCLinuxOS installation (with
the updated kernel) to ensure the changes have
been made.

Back to the topic of Spectre and Meltdown, these
design flaws have been a part of Intel’s processors
for the past twenty years. These design flaws
allow cyber intruders to remotely obtain personal
information (including passwords) without your
knowledge, or even without logging in to your
PCLinuxOS machine, especially after a system
update that requires a reboot (such as a Plasma
desktop upgrade). This means any machine with a
Intel processor built since 1998 has this design
flaw.

Having said that, this brings up some serious issues.

As revealed in the MS vs DOJ Antitrust Case of
1998, Microsoft made secret deals with computer
manufacturers back in 1990 to include only
Windows on the hard drive, and to not offer any
alternatives available at the time such as IBM’s
OS/2 (now Arca Noae’s ArcaOS) and Solaris.

What was Intel’s role in that? The original IBM
Personal Computer (Model 5151) was built on an
Intel 8088 processor rather than a Motorola 6502 or
68000 processor. As the market grew for personal
computers, businesses and individuals alike

wanted compatibility with the IBM Personal
Computer, but wanted that compatibility at a lower
cost. (Rather obvious isn’t it?)

By the middle 1990s, most personal computers in
the market were equipped with Intel processors and
Windows installed on the hard drives (supposedly
making it easier for the customer, but I never
believed that).

The result of all of this was the Wintel monopoly.

This meant that Microsoft and Intel had virtually
complete control of the hardware and software
market. This also meant that if any problems
manifested themselves, both companies could well
sit on the problem for months, even years at a time
before anything was done about them.

Sound familiar?

Thankfully, the introduction of Linux and the open
source concept to the mainstream at the Fall
Comdex 1998 intended to change all of that.

The idea behind the open course concept (as well
as the Debian social contract) is to make sure there
is transparency in everything technology related.
That is, any problems that manifest themselves
should be resolved as soon as possible and not
hidden from the public.

Why is this important? Look no further than the
WannaCry malware and what it did to a hospital
system in the UK. When computers are used in
critical setting such as a hospital or a nuclear plant,
we want these systems to be working properly,
and proper precautions taken, and we want the
integrity of these systems to not be
compromised. In other words, these computers

From the "I Told You So" Department #1
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should be maintained as if our lives depended on it,
because they do!

The question here is this:

Why did Intel hide this design flaw from the
public for the past twenty years?

Was it gross negligence on Intel’s part, or was it
blatant dishonesty. Common practices in
monopolies over the past two centuries suggest the
latter. To hide a problem for that long and make
money off of it is clear cut evidence that dishonesty
is the case.

Thankfully, we have fixed the problem in software
(as Texstar did with the kernels), and it is up to us to
apply the fixes. What Intel wants businesses to do is
to replace all older computers with new
computers.

One could argue that this statement was a result of
a declining market for personal computers, mainly
because of the growing market for mobile devices.
Even then, the mobile device market has its share of
growing pains as well (in the form of design flaws
and malware now targeted iOS and Android
devices).

What I speculate from all of this is that the consumer
is tired of all the b******* coming from the tech
companies (both hardware and software aspects, as
well as the networks they connect to) and
particularly from Silicon Valley.

It is not just me who is speculating this. Simply visit
Richard Stallman’s personal website
(http://stallman.org) and his views on technology. He
has been contributing to computing since the 1970s,
and is one of the founding fathers of the open
source movement.

Also, check out the Free Software Foundation
website (https://www.fsf.org) as well as their
Defective by Design website.

As we cannot rely on our government (state and
federal levels) to do its job of protecting consumers
(where is Ralph Nader when we need him?). It is up
to us to resolve these matters, and to be able to
make our own decisions with integrity, and most of
all with common sense.

Also, I have my views on the Microsoft vs DOJ
Antitrust Case of 1998 archived in the Internet
Archive.

So, what do I do to protect myself and my cyber
assets?

First, I do not run my laptop 24/7. By that, I mean
that the machine does not have to be powered on all
the time. In fact, it is powered up when I need to
have it on, and when I do not need to use the laptop,
it is powered down.

By not having the machine powered on all the time,
it is difficult for would be cyber criminals to plan their
attack… and that is a good thing.

Second, there is a cliche that has been around for
decades, that still applies today. If an offer seems
too good to be true, it probably is. Be it in the
form of physical junk mail, or an ad infested email,
the principle still applies. Same with unsolicited
phone calls. Those go direct to voicemail. If it is
important, the caller will leave a message. If not, it
was probably not that important (or even legitimate)
anyway.

Third, if I cannot tell if a story is legitimate or is “fake
news”, assume the latter, and don’t trust anything
until I can verify beyond a shadow of a doubt that
the information is true.

For those of you who remember the TV miniseries
“Centennial” (around 1980), there is a quote that
could well apply today. It is one of the last quotes
found in the last episode towards the end of that
episode.

“We have got to look at our past, and go back to
basics, if we expect to have a future.”

It could not be more true today.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

From the "I Told You So" Department #1

mailto:pclinuxos.mag@gmail.com
http://www.jupiterbroadcasting.com/tag/linux-action-show/
http://www.fsf.org
https://www.fsf.org
https://www.defectivebydesign.org/
http://stallman.org
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as told to YouCanToo

What is your name/username?
timj_bsgcgoty2003

How old are you?
64

Are you married, single?
Married to Jane, a School Training Administrator

How about Kids, Grandkids (names and ages)?
Two girls - Stella in her 2nd year as a real (i.e. paid)
doctor, and Pippa in her 3rd year as a Speech and
Language Therapist. There's nobody medical in our
immediate family, so we don't know where those
career choices came from!

Do you have pets, what is your favorite?
Not at the moment. Our last cat, Louise, died two
years ago and we are now prevaricating. The girls
want us to get another cat.

Are you retired, still working and if working, what
do you do?
Redundancy from retail banking in the City and West
End (not the very well paid sector, sadly) in 2003,
and ten years of interesting short term local jobs,
e.g. Data Manager at a school. Retired four years
ago but still active in the charity sector.

Where do you call home? What is it like? IE:
weather, scenery
Sawbridgeworth, Hertfordshire, England (25 miles
NE of London - nearest larger town is Bishop's
Stortford). Lovely leafy and green town loved by
commuters. Typical English weather, e.g. top
temperature today 22C/71.6F, yesterday 17C/62.6F.

Where did you go to school and what is your
education level?
I went to a Grammar School in the North of England
before coming to London to university, where I
graduated with an honours degree in Physics. I've
never used it since and went straight into banking.

The Orange Tree country pub and restaurant

RAF Sawbridgeworth UK - World War II Memorials / Monuments

The Old Bell Pub and Inn

PCLinuxOS Family Member Spotlight:
timj_bsgcgoty2003

http://www.fsf.org
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What kind of things you like doing? hobbies,
travel, fishing, camping?
I have played golf for over 50 years, and still play to
a decent standard. (There is a golf reference in my
username if anyone can work it out as I play at
Bishop's Stortford Golf Club). I sing with a couple of
choirs, and have been a member of one of them for
over 40 years - a male voice choir who are growing
old disgracefully.

Why and when did you start using Linux?
About four years ago when Microsoft started telling
me my Windows XP installation wasn't legal, even
though I had the DVD and licence sticker. I could not
stop it interrupting my work, so I swallowed hard and
dipped my toes in the Linux water. It's (generally)
great, although I'm a wuss where the use of the
command line is concerned, as I class myself as a
high level user of software, but not the operating
system.

What specific equipment do you currently use
with PCLOS?
A brand spanking new German PC with AMD A8-
5545M Quad Core 2.7 GHz x 4, Bio star A68N-5545
BIOS, HL-DT-ST DVDRAM GH24NSD1 Disk drive,
Radeon HD 8510G Video, 8 GB RAM, WDC 1TB
HDD. It goes like the wind.

What would you like to see happen within
PCLOS that would make it a better place. What
are your feelings?
I think it's all brilliant. The helpful attitude on the
forum, the tireless work put in by the packagers, and
the expertise of the Top Team are all beacons of
excellence in human relations.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS

forum member. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Gt St Mary’s Church

Screenshot ShowcaseScreenshot Showcase

Posted by Lifeless_user, January 27, 2018, running LXDE.

PCLinuxOS Family Member Spotlight: timj_bsgcgoty2003
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Ingredients:

4 boneless skinless chicken breasts (1 1/4 lb)
1 teaspoon salt
1/2 teaspoon ground black pepper
2 tablespoons olive oil
1 cup chicken broth
1 can (14.5 oz) fire roasted diced tomatoes,
undrained
1 cup uncooked orzo or rosamarina pasta
1 package (8 oz) fresh mozzarella pearls, drained
1/4 cup shredded fresh basil leaves

Directions:

Rub chicken with 1/2 teaspoon of the salt and the
pepper. In 12-inch nonstick skillet, heat oil over
medium-high heat. Add chicken; cook 3 to 4 minutes
on each side or until browned. Remove chicken from
skillet.

Add broth, tomatoes and remaining 1/2 teaspoon
salt; heat to boiling. Stir in pasta; return to boiling.
Place chicken over pasta. Reduce heat to medium-
low; cover and simmer 12 to 16 minutes or until most
of liquid is absorbed, pasta is tender and juice of
chicken is clear when center of thickest part is cut (at
least 165F).

Top mixture with mozzarella pearls; cover, and
continue to cook over medium-low heat 2 to 4
minutes or until mozzarella slightly melts. Sprinkle
with basil.

Tips: Can't find mozzarella pearls? Substitute 1 cup
shredded mozzarella.

Defending Your Rights

In The Digital World

PCLinuxOS Bonus Recipe Corner

Chicken and Orzo Skillet

http://chimpbox.us
https://www.eff.org/
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Tex was born on a farm down in Arkansas
A happy youth full of hoopla

He scratched his brain folks thought him insane

Always fiddling with his 'puter near
Loved the purr of the tune he could hear

He would boot it up make a backup
Sounds like a genius to me

Said he'd show those Windows' fools
Didn't go to boot camp schools

Never played by the rules
That's called genius

Linux code appealed to him
Through the source he did skim

Wrote it all using Vim
That's called genius

He now has an OS of his own
PCLOS my how it has grown
Had no help he did it all alone

Download it now get it for free
It's the best we all agree

You must admit he made a hit
Sounds like a genius to me

ms_meme's Nook: Sounds Like A Genius To Me

MP3 OGG

http://pclosmag.com/html/Issues/201802/files/soundslikeagenius.mp3
http://pclosmag.com/html/Issues/201802/files/soundslikeagenius.ogg
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Editor’s Note: Tip Top Tips is a semi-monthly column in
The PCLinuxOS Magazine. Periodically, we will feature –
and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept
independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a
tip, share it in the PCLinuxOS forum’s “Tips & Tricks”
section. Your tip just may be selected for publication in
The PCLinuxOS Magazine.

This month’s tip comes from reelcat.

Since Qt5 apps appeared in PCLinuxOS, it was very
annoying to me that I could not set up their
appearance in Trinity. There was no problem with
Qt4, even Qt3, but Qt5 apps changed their style,
font, color etc exclusively in KDE Plasma 5. And
there were quite a few of them: SMPlayer, VLC,
Master PDF Editor, Openshot, and their number was
growing.

When the Qt5ct config app appeared in our repo, I
tried to configure the look of the Qt5-based
applications, but to no avail. Qt5ct, a Qt5 app, did
not change even itself, saying nothing of changing
other Qt5 apps. I gave up, convinced that maybe a
Qt5 library that did the look change was not present
in my installed system, and I could not identify it.

But it lasted only until recently. One of the recent
upgrades did make Qt5ct change its look. I started
Googling, experimenting and I think I found a way to
configure the look of Qt5 apps.

Run Qt5ct and set the look as you like. I used
Fusion widget (close enough to Plastique),
Crystalsvg icons (TDE default set) and Charcoal 10
font (for its excellent readability). You should see

how Qt5ct will look with your settings. Also, you can
define your colors for the whole theme.

Run Menu Configurator and add the option --
platformtheme qt5ct at the end of the command
for running a Qt5 application you want to change
its look. For example, to change the look of
QMPlay2:

QMPlay2 --platformtheme qt5ct

In most cases this should change the look of this
application.

QMPlay2 before:

QMPlay2 after:

Notice that not only the font changed, but also the
icons.

But not all application can support this suffix. VLC,
for example, considers --platformtheme qt5ct as an
invalid option and simply does not run at all. To solve
this problem, a user-wide approach is needed. It
turns out that the only thing to change the look of all
Qt5 apps is setting the
QT_QPA_PLATFORMTHEME variable, which is not
set in TDE.

Of course, this makes unnecessary adding the
--platformtheme qt5ct option at the end of program
command and you can safely remove it.

As user, edit the file .bash_profile in your home
directory. It is hidden so you have to turn on the
option "Show hidden files". Add one line:

export QT_QPA_PLATFORMTHEME="qt5ct"

Linux Training
Courses & Classes

Tip Top Tips: Qt5 Settings In Trinity

http://www.pclinuxos.com/forum/index.php/topic,144704.msg1236044.html#msg1236044
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Save your work and re-login. Now all Qt5
applications should look as supposed.

I hope this short how-to will be useful for the
PCLinusOS Trinity users to configure Qt5
applications.

Screenshot ShowcaseScreenshot Showcase

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http://twitter.com/iluvpclinuxos

Posted by tbschommer, January 2, 2018, running KDE.

Tip Top Tips: Qt5 Settings In Trinity

http://chimpbox.us
mailto:pclinuxos.mag@gmail.com
http://twitter.com/iluvpclinuxos
http://www.commandlinefu.com
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w

n
lo

ad
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u
zz

le
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o
lu

ti
o

n
s

H
er

e

Possible score 266, average score 186.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201802/files/2018-02-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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admiration adoration

aggravation anger

astonishment cautious

cheerful compassionate

concerned delighted

depressed disappointment

dissatisfied disturbed

ecstatic elated

embarrassed enthusiastic

envious frightened

furious grouchy

happiness infatuated

infuriated jealous

jolly kindhearted

loathing love

nervous pensive

pessimistic proud

quarrelsome rage

sarcastic sympathetic

tense worried

D E Y K L R I V C I T S I M I S S E P T F Y X A U B Y X H L
S E X Q Q T B P K L I G F F U S R I K C E T Z H B R M W Q L
R G P K Y D A D T T G T Z R N E W N S F E N E W O C B R L C
A P F R I G H T E N E D A Y G C N S P L I P S M Y X D B I C
G S K I E P G E C R C I X Q R L I O S K L Z M E W W E Q Z B
E H Z T E S W A K P I T J L K O U T Q E G Y Y H Z O I D C S
U Y X J O I S S U O L A E J C O T E S J N D F W Z S F D H R
Z J E V I S N E P U T H O A M C V M V A L I W B O Y S C N Q
A F K Z H S P V D J I R Q C E W R O K J C S P P I Y I I O F
Q F H G Z B T L Z M Y L Y Z W M X S O F U R F P Y K T T I E
E T A N O I S S A P M O C H F R H L X O J G A I A Y A E T C
E C S D I I N F U R I A T E D B L E I V D N H S O H S H A R
D J O B I R A L L U E G N O I T A R O D A Y D J W A S T R O
I K K V T R I L S U W Y O M W D U R X V F H L N R J I A I I
S W Y E H Y W F Y Q A I D F M F C A U E Y E V A S O D P M N
T L U T P G G K V A A S E R D D Z U F Q Y G Z M C L R M D F
U U P E I E R S B Q N U I P K O E Q V V Z F P O D L C Y A A
R O D E E L O L H D G O R Q A F S L I A R S N C U Y N S W T
B L E J U S U G E E E V R K Q T X M I G R C T O J Z O G H U
E C T L V F C W J L R R O Q N E E O R G E B R R M L Y N M A
D E R C R W H G O O L E W E M E C O U R H F R C U R I I C T
G J A E W C Y B K G H N M B B J S S N A H T L N A J J H V E
Q I E Q F Z R Y O D Y H M O H C H E T V G V E P E D T T I D
W H H X R E C Q S X S D T F W B D H E A W P Z D S V C A G P
C F D J X K S U O I T U A C K W L Y N T T P B K O Q O O H E
S M N S O G H Y N U D I Q L P G I Y B I T I O L Y S L L L E
P E I Q H L J O D E S S A R R A B M E O J Y C V O O U A I P
B Y K T V P T J P R O U D C R H C O E N V I O U S V T H R J
S N L T U S U E N T H U S I A S T I C X E C J F B E B Z U D
G N V H A P N E V J X T N E M T N I O P P A S I D J J O I O

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

PCLinuxOS Word Find: February 2018
Emotions / Feelings

http://pclosmag.com/html/Issues/201802/files/2018-02-PuzzleSolutions.pdf
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1. feeling or showing a state of self-conscious
confusion and distress

2. having had its normal pattern or function disrupted
3. anxious or troubled about actual or potential

problems
4. violent, uncontrollable anger
5. a feeling of respect and approval
6. feeling or showing a desire to have what someone

else has
7. feeling or expressing overwhelming happiness or

joyful excitement
8. a person in a state of general unhappiness or

despondency
9. full of anger or energy; violent or intense
10. feeling or showing envy of someone or their

achievements and advantages
11. engaged in, involving, or reflecting deep or serious

thought
12. an intense feeling of deep affection
13. marked by or given to using irony in order to mock

or convey contempt
14. to understand and care about someone else's

suffering
15. feeling or showing sympathy and concern for

others
16. overpowering wonder or surprise
17. an act or circumstance that intensifies something

or makes something worse
18. having or showing intense and eager enjoyment,

interest, or approval

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Emotions / Feelings Crossword

http://pclosmag.com/html/Issues/201802/files/2018-02-PuzzleSolutions.pdf
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From the computer of ms_meme:
Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous people. The magazine article
about secure passwords made me think of the cryptograms. We have people in the forum who are always posting famous/wise/silly sayings. I have made a few
into cryptograms, and hope our readers will enjoy them.

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Cryptograms

http://pclosmag.com/html/Issues/201802/files/2018-02-PuzzleSolutions.pdf


PCLinuxOS Magazine Page 36

Posted by Gonzalo_VC, January 2, 2018, running MATE. Posted by luikki, January 12, 2018, running KDE.

Posted by noob_it, January 19, 2018, running KDE. Posted by HERTZ, January 7, 2018, running MATE.

More Screenshot Showcase




